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Overview 1
Intel® Integrated Performance Primitives (Intel® IPP) is a software library which provides 
a broad range of functionality including general signal, image, speech, graphics, data 
compression, cryptography, text strings and audio processing, vector manipulation and 
matrix math, as well as more sophisticated primitives for construction of audio, video and 
speech codecs such as MP3 (MPEG-1 Audio, Layer 3), MPEG-4, H.264, H.263, JPEG, 
JPEG2000, GSM-AMR*, and G.723, plus computer vision. 

By supporting a variety of data types and layouts for each function and minimizing the 
number of data structures used the Intel IPP library delivers a rich set of options for 
developers to choose from while designing and optimizing an application. A variety of data 
types and layouts are supported for each function. Intel IPP software minimizes data 
structures to give the developer the greatest flexibility for building optimized applications, 
higher level software components, and library functions.

Intel IPP for Windows* OS are delivered in separate packages for:

• users who develop on 32-bit Intel architecture (Intel IPP for the Windows* OS on 
IA-32 Intel® Architecture)

• users who develop on Intel® 64-based (former Intel EM64T) platforms (Intel IPP for 
the Windows* OS on Intel® 64 Architecture)

• users who develop on Intel® Itanium® 2 processor family platforms (Intel IPP 6.0 for 
the Windows* OS on IA-64 architecture)

Technical Support
Intel provides a support web site which contains a rich repository of self-help information, 
including getting started tips, known product issues, product errata, license information, 
user forums, and more. Visit the Intel IPP support web site at 
http://www.intel.com/software/products/support/ipp.

http://www.intel.com/software/products/support/ipp
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About This Document
This document, Intel® IPP for the Windows* OS on the IA-32 Architecture User’s Guide, 
focuses on the usage information needed to make the most of Intel IPP routines using the 
Windows applications running on the IA-32 architecture. This usage of Intel IPP has its 
particular features. The User’s Guide describes these features along with those that do not 
depend upon a particular architecture.

After installation, you may find this document in the <install path>\doc directory (see 
Contents of the Documentation Directory).

Purpose
This document

• Helps you start using the library by describing the steps you need to perform after the 
installation of the product.

• Shows how to configure the library and your development environment to use the 
library.

• Acquaints you with the library structure.

• Explains in detail how to select the linking method that suits you best, how to link your 
application to the library and provides simple usage scenarios.

• Explains how to thread your application using IPP software.

• Describes how to code, compile, and run your application with Intel IPP.

• Gives information how to accomplish Intel IPP functions performance tests by using 
Intel IPP Performance Test Tool.

• Describes types of Intel IPP sample code available for developers to learn how to use 
Intel IPP and explains how to run the samples.

Audience
This guide is intended for Windows programmers whose software development experience 
may vary from beginner to advanced.
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Document Organization
The document contains the following chapters and appendices.

Chapter 1 Overview describes the document purpose and organization as well 
as explains notational conventions.

Chapter 2 Getting Started with Intel® IPP describes necessary steps and 
gives basic information needed to start using Intel IPP after its 
installation. 

Chapter 3 Intel® IPP Structure describes the structure of the Intel IPP 
directory after installation and discusses library types supplied.

Chapter 4 Configuring Your Development Environment explains how to 
configure Intel IPP and your development environment for the use 
with the library.

Chapter 5 Linking Your Application with Intel® IPP compares linking 
methods; helps selecting a linking method for particular purpose, 
describes the general link line syntax to be used for linking with the 
Intel IPP libraries; discusses how to build custom dynamic libraries.

Chapter 6 Supporting Multithreaded Applications helps you set number of 
threads in multithreaded applications, get information on number 
of threads, disable multithreading.

Chapter 7 Managing Performance and Memory discusses ways of improving 
Intel IPP performance; gives information how to accomplish Intel 
IPP functions performance tests by using Intel IPP Performance 
Test Tool.

Chapter 8 Using Intel® IPP with Programming Languages discusses some 
special aspects of using Intel IPP with different programming 
languages and Windows development environments.

Appendix A Performance Test Tool Command Line Options gives brief 
descriptions of possible performance test tool command line 
options.

Appendix B Intel® IPP Samples describes types of the Intel IPP sample code 
available for developers to learn how to use the Intel IPP, presents 
the source code example files by categories with links to view the 
sample code, and explains how to run the samples using the 
example of simple media player application.

The document also includes an Index.
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Notational Conventions
The document employs the following font conventions and symbols: 

Table 1-1 Notational conventions

Italic Italic is used for emphasis and also indicates document names in 
body text, for example, see Intel IPP Reference Manual

Monospace lowercase Indicates filenames, directory names and pathnames:
\tools\env\ippenv.bat

Monospace lowercase 
mixed with uppercase

Indicates code, commands and command-line options:
ippsFFTGetBufSize_C_32fc( ctxN2, &sz );

UPPERCASE MONOSPACE Indicates system variables, for example, PATH

Monospace italic Indicates a parameter in discussions: function parameters, for 
example, lda; makefile parameters, for example, functions_list; 
and so on.
When enclosed in angle brackets, indicates a placeholder for an 
identifier, an expression, a string, a symbol, or a value:
    <ipp directory>. 

[ items ] Square brackets indicate that the items enclosed in brackets are 
optional.

{ item | item } Braces indicate that only one of the items listed between braces can 
be selected. A vertical bar ( | ) separates the items
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This chapter helps you start using Intel IPP by giving basic information you need to know 
and describing the necessary steps you need to perform after the installation of the 
product.

Checking Your Installation
Once you complete the installation of the Intel IPP, it is useful to perform a basic 
verification task that confirms proper installation and configuration of the library. 

1. Check that the directory you chose for installation has been created: <installation 
path>\Intel\IPP\6.0.x.xxx\ia32. The default installation directory is 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32.

2. Check that the file ippenv.bat is placed in the \tools\env directory: you can use 
this file to set the environment variables PATH, LIB, and INCLUDE in the user shell.

3. Check that the dispatching and the processor-specific libraries are on the path.

4. Run ippiDemo.exe (or ippsDemo.exe) from the C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\demo.

If you receive error messages “This application has failed to start because 
ippcore.dll was not found” or "No DLL were found in the waterfall procedure", this 
means that the operating system is unable to determine the location of the Intel 
IPP dynamic libraries. To solve this issue:

• Ensure that the Intel IPP directory is in the path: before using the Intel IPP 
dynamic libraries, add C:\Program Files\Intel\IPP\6.0.x.xxx\ia32 to 
the PATH environment variable as described in Setting Environment Variables;

• Manually copy the contents of IPP\6.0.x.xxx\ia32\bin to the \system32 
directory;
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• Copy contents of IPP\6.0.x.xxx\ia32\bin to the application directory.

Note that you need to delete all Intel IPP DLLs from previous releases from the 
C:\winnt\system and C:\winnt\system32 directories. Verify that paths to 
older library versions are not listed in the PATH environment variable.

Obtaining Version Information
To obtain information about the active library version including the version number, 
package ID, and the licensing information, call the ippGetLibVersion function. See the 
”Support Functions” chapter in the ”Intel IPP Reference Manual” (v.1) for the function 
description and calling syntax.

You may also get the version information in the ippversion.h file from the \include 
directory.

Building Your Application
Follow the procedures described below to build the application.

Setting Environment Variables
The batch file ippenv.bat  in the \tools\env directory sets the Intel IPP LIB, INCLUDE, 
and PATH environment variables for a command prompt session. 

To set the environment variables outside of a single command prompt session, complete 
the following steps, for example in the Windows XP* OS:

1. Right-click the My Computer icon on your desktop or from the Windows Explorer* 
and select Properties (or open Control Panel and select System), 

2. Select the Advanced tab,

3. Select the Environment Variables button,

4. Use the interface to set the environment variables for only the current user (top dialog 
box) or for anyone who uses the system (bottom dialog box),

5. Select the variable you wish to modify and click the Edit button,
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6. Add the path to the related Intel IPP files to the existing list. For example: 

Select LIB and type in the directory for the Intel IPP stub libraries (default is: 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\stublib), 

Select INCLUDE and type in the directory for the Intel IPP header files (default is: 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\include),

Select PATH and type in the directory for the Intel IPP binaries (default is: 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\bin).

7. Click OK in the Edit User Variable dialog box,

8. Click OK in the Environment Variables dialog box,

9. Click OK in the Systems Properties dialog box.

For information on how to set up environment variables for threading, refer to Supporting 
Multithreaded Applications.

Including Header Files
Intel IPP functions and types are defined in several header files that are organized by the 
function domains and located in the \include directory. For example, the ippac.h file 
contains declarations for all audio coding and processing functions.

The file ipp.h includes all Intel IPP header files. For forward compatibility, include only 
ipp.h in your program.

Calling IPP Functions
Due to the DLL dispatcher and merged static library mechanisms described in Linking Your 
Application with Intel® IPP, calling Intel IPP functions is as simple as calling any other C 
function.

To call an Intel IPP function, do the following:

1. Include the ipp.h header file 

2. Set up the function parameters 

3. Call the function 

The multiple versions of optimized code for each function are concealed under a single 
entry point. Refer to the “Intel IPP Reference Manual” for function descriptions, lists of 
required parameters, return values and so on.
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Before You Begin Using Intel IPP
Before you get started using Intel IPP, sorting out some important basic concepts will help 
you get off to a good start.

Table 2-1 summarizes some important things to consider before you start using Intel IPP.

Table 2-1 What you need to know before you get started

Function domains Identify the Intel IPP function domain that meets your needs.
Reason: The knowing of the function domain you intend to use 
will narrow the search in the Reference Manuals for specific 
routines you need.
Besides, you may easily find a sample you would like to run from 
http://www.intel.com/software/products/ipp/samples.htm.
Refer to Table 5-8 to understand what function domains are and 
what libraries are needed, and to Table 5-9 to understand what 
kind of cross-domain dependency is introduced. 

Linking method Decide what linking method is appropriate for linking. 
Reason: If you choose a linking method that suits you most of 
all, you will get the best linking results. For information on the 
benefits of each linking method, linking command syntax and 
examples, as well as on other linking topics, like how to create a 
custom dynamic library, see Linking Your Application with Intel® 
IPP

Threading model Select among the following options how you are going to thread 
your application:
• Your application is already threaded
• You may want to use the Intel® threading capability, that is, 

Compatibility OpenMP* run-time library (libiomp), or a 
threading capability provided by a third-party compiler.

• You do not want to thread your application.
Reason: By default, Intel IPP uses the OpenMP* software to set 
the number of threads that will be used. If you need a different 
number, you have to set it yourself using one of the available 
mechanisms. For more information, see Supporting 
Multithreaded Applications.

http://www.intel.com/software/products/ipp/samples.htm
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This chapter discusses the structure of Intel IPP after installation as well as the library 
types supplied.

High-level Directory Structure
Table 3-1 shows a high-level directory structure of Intel IPP after installation.

Table 3-1 High-level directory structure

Directory File types

<ipp directory> Main directory (by default: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32)

<ipp directory>\ippEULA.rtf End User License Agreement for Intel IPP

<ipp directory>\bin Intel IPP dynamic link libraries (DLLs)

<ipp directory>\demo Executable programs that demonstrate various image 
and signal processing functionalities

<ipp directory>\doc Intel IPP documentation files

<ipp directory>\include Intel IPP header files

<ipp directory>\lib Intel IPP static libraries

<ipp directory>\stublib Intel IPP import libraries, used for linking DLLs.

<ipp directory>\tools Intel IPP Performance Test tool, linkage tools, and tool 
to set environment variables
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Supplied Libraries
The following Table 3-2 lists types of libraries of Intel IPP and examples of library files 
supplied:

Using Intel IPP Dynamic Link Libraries (DLLs)
Intel IPP comes with the dynamic link libraries (DLLs) in the \ia32\bin directory. 

To load the Intel IPP DLLs and link to the correct entry points, use "stub" library files in the 
\ia32\stublib directory that come with the Intel IPP package (see Table 3-1).

To use the DLLs, link to the ipp*.lib files. You must to set your lib environment variable 
using the ippenv.bat file or refer to these files using their full path. Including these 
libraries is all you need to do to dynamically link to the DLL for the appropriate processor.

The DLLs ipp*-6.0.dll (* denotes the appropriate function domain) are "dispatcher" 
dynamic libraries. At run time they detect the processor and load the correct 
processor-specific DLLs. This allows your code to call the Intel IPP functions without 
worrying about which processor the code will execute on -  the appropriate version is 

Table 3-2 Types of Libraries of Intel IPP

Library types Description Folder location Example

Dynamic Dynamic link libraries 
(DLLs) include both 
processor dispatchers 
and function 
implementations

\ia32\bin ipps-6.0.dll, 
ippst7-6.0.dll

Static (import) "Stub" static library files. 
They loads the required 
DLLs and link to the 
correct entry points.

\ia32\stublib ipps.lib

Static merged Contain function 
implementations for all 
supported processor 
types

\ia32\lib ippsmerged.lib

Threaded static 
merged

Contain threaded function 
implementations

\ia32\lib ippsmerged_t.lib

Static emerged Dispatchers for the 
merged libraries

\ia32\lib ippsemerged.lib
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automatically used. These processor-specific libraries are named ipp*px-6.0.dll, 
ipp*w7-6.0.dll, ipp*t7-6.0.dll, ipp*v8-6.0.dll, and ipp*p8-6.0.dll (see 
Table 5-3). For example, in the \ia32\bin directory, ippiv8-6.0.dll reflects the imaging 
processing libraries optimized for the Intel® CoreTM 2 Duo processors.

-6.0-6.0dll-6.0dll-6.0dll-6.0dll-6.0The only actions needed to use the Intel IPP 
DLLs, once the "stub" static libraries are linked, is to ensure that the dispatching DLLs and the 
processor-specific DLLs are on the path.

See also Selecting Intel IPP Libraries Needed by Your Application.

The first and the simplest  example of calling IPP function could be the following code in file 
t1.cpp:

Using Intel IPP Static Libraries
The Intel IPP comes with "merged" static library files that contain every processor version of 
each function. These files reside in the \ia32\lib directory (see Table 3-1).

NOTE.  It is required that the appropriate libiomp5md.dll is also 
included in your PATH environment variable. Include the directory bin 
when running on a system with IA-32 architecture.

Example 3-1 Code calling example

#include <stdio.h>
#include <ipp.h>

int main() {
const IppLibraryVersion* libver = ippGetLibVersion();
printf("%s %s\n", libver->Name, libver->Version);
return 0;

}

cmdlinetest>cl /nologo /Fet1.exe -I "C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\include\" t1.cpp "C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\stublib\ippcore.lib" 
t1.cpp

cmdlinetest>t1.exe
ippcore-6.0.dll 6.0 build 81
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Just as with the dynamic dispatcher, the appropriate version of a function is executed when 
the function is called.  This mechanism is not as convenient as the dynamic mechanism, 
but can result in a smaller total code size in spite of the big size of the static libraries.

To use these static libraries, link to the appropriate files ipp*merged.lib in the \lib 
directory. You will either need to set your LIB environment variable using the ippenv.bat 
file or refer to these files using their full path.

See also Selecting Intel IPP Libraries Needed by Your Application.

Contents of the Documentation Directory
Table 3-3 lists the main documents places in the \doc subdirectory in the Intel IPP 
installation directory.

Table 3-3 Contents of the \doc Directory

File name Description Notes

ipp_documentation.htm Documentation index. Lists the principal 
Intel IPP documents with appropriate links 
thereto

ReleaseNotes.htm General overview of the product and 
information about this release. This files can be 

viewed prior to the 
product installation

README.txt Initial User Information

INSTALL.htm Installation guide

ThreadedFunctionsList.
txt

List of all Intel IPP functions threaded with 
the OpenMP*

userguide_win_ia32.pdf Intel® Integrated Performance Primitives 
User’s Guide, this document

Intel IPP Reference Manual (in four volumes):

ippsman.pdf Signal Processing (vol.1) - contains 
detailed descriptions of Intel IPP functions 
and interfaces for signal processing, audio 
coding, speech recognition and coding, 
data compression and integrity, string 
operations and vector arithmetic.

ippiman.pdf Image and Video Processing (vol.2) - 
contains detailed descriptions of Intel IPP 
functions and interfaces for image 
processing and compression, color and 
format conversion, computer vision, video 
coding.
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ippmman.pdf Small Matrices, Realistic Rendering (vol.3) 
- contains detailed descriptions of Intel IPP 
functions and interfaces for vector and 
matrix algebra, linear system solution, 
least squares and eigenvalue problems as 
well as for realistic rendering and 3D data 
processing

ippcpman.pdf Cryptography (vol.4) - contains detailed 
descriptions of Intel IPP functions and 
interfaces for cryptography

Table 3-3 Contents of the \doc Directory

File name Description Notes
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This chapter explains how to configure your development environment for the use with 
Intel® IPP.

Configuring Microsoft* Visual C++* .NET 2003 or 
Microsoft Visual C++*2005 Software to Link with Intel 
IPP

To configure Microsoft* Visual C++* .NET 2003 or Microsoft* Visual C++* 2005 
environments to link with Intel IPP, follow the sequence of steps below:

1. Select View > Solution Explorer (make sure this window is active). 

2. Select Tools > Options > Projects and Solutions > VC++ Directories. 

3. In the drop down menu Show directories for:, select Include Files, and type in the 
directory for the Intel IPP include files (for example, default is: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\include). 

4. In the drop down menu titled Show directories for:, select Library Files, and then 
type in the directory for the Intel IPP library files (for example, default is: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\stublib or C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\lib). 

5. In the drop down menu Show directories for:, select Executable Files, and type in 
the directory for the Intel IPP executable files (for example, default is: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\bin).

6. On the main toolbar, select Project  > Properties > Linker > Input, in the 
Additional Dependencies line add the libraries you wish to link to (for example, 
ipps.lib or ippsmerged.lib). For more information on choosing the best linking 
method for your Intel IPP application, please refer to Linking Your Application with 
Intel® IPP.
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Creating Visual C++ 2005 Project Files for the Intel® IPP 
Samples

To create Microsoft* Visual* C++ 2005 project files for the Intel IPP samples, follow the 
steps described below taking jpegview sample code as an example.

1. Download the media codec sample jpegview from 
http://www.intel.com/software/products/ipp/samples.htm .

2. Select File > New > Project from Existing Code:

3. Select Visual C++ as type of project you would like to create from the dropdown 
menu in the popup window. Fill in the project file location and project name. Check 
Add files to the project from these folders check box. Click Add, select jpegview 
folder, and click OK. 

4. Select View >Solution Explorer (make sure this window is active). 

5. Select Projects > Properties. 

6. Under Configuration Properties > C/C++ in the drop down menu titled Show 
directories for:, select Include Files, and type in the directory for the Intel IPP 
include files (for example, default: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\include). 

7. In the drop down menu titled Show directories for:, select Library Files, and type 
in the directory for the Intel IPP library files (for example, default: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\stublib or C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\lib). 

8. In the drop down menu titled Show directories for:, select Executable Files, and 
type in the directory for the Intel IPP executable files (for example, default: 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\bin). 

Building a Microsoft* Visual C++ .NET* Solution for the UMC 
Sample Code

To generate the Microsoft* Visual C++ .NET* project and solution files for the Intel IPP 
UMC sample code, use the script file gen_vsproj.pl that can be downloaded from 
http://www.intel.com/support/performancetools/libraries/ipp/win/ia/sb/cs-022835.htm. It 
works under Microsoft Windows* OS with the ActivePerl* script installed. This script can 
build solution files for Intel® C++ Compiler 10.0, Microsoft* Visual C++ .NET* 2005. Here 
are some notes for using this script:

http://www.intel.com/software/products/ipp/samples.htm
http://www.intel.com/support/performancetools/libraries/ipp/win/ia/sb/cs-022835.htm
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1. Put the script file in the Intel IPP UMC sample code folder: 
\ipp-samples\audio-video-codecs.

2. At the command line, use gen_vsproj.pl command to create solution files. Typing 
“gen_vsproj.pl” will print all command messages. Here is an example to generate 
Microsoft Visual C++.NET 2003 solutions for applications with the IA-32 architecture:

>gen_vsproj.pl -vs2003 -noicl -con application\* -gui
application\umc_reverb_demo -dll plug-in\audio_codecs -lib 
codec\* core\* io\* pipeline\* plug-in\object_factory -
I"javascript:void(null);" -win32 -L "javascript:void(null);" 
"javascript:void(null);" -l "javascript:void(null);" ddraw.lib 
dsound.lib

Solution files are located in the ipp-samples\audio-video-codecs\application\xxxx 
directories.

For details on running Intel IPP sample code, see Appendix , “Intel® IPP Samples”.

Using Intel® IPP with Intel® C++ Compiler
Using Intel IPP with Intel C++ Compiler is similar as using Intel IPP with Microsoft* C++ 
Compiler.

In Microsoft Visual C++* .NET environment, instead of providing settings at Tools > 
Options > Projects > VC++ Directories, choose to provide settings at  Tools > 
Options > Intel® C++ by the following steps:

1. Select View > Solution Explorer (and make sure this window is active),

2. Select Tools > Options > Projects > Tools > Options > Intel® C++ > Intel® 
C++ XX, 

3. In the drop down menu Show directories for:, select Include Files and then type in 
the directory for the Intel IPP include files (for example, default is: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\include), 

4. In the Include path, type in the directory for the Intel IPP library files (for example, 
default is: C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\stublib or 
C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\lib),

5. In the library path, type in the directory for the Intel IPP executable files (for example, 
default: C:\Program Files\Intel\IPP\6.0.x.xxx\ia32\bin), 

6. On the main toolbar, select Project > Properties > Linker > Input and in the 
Additional Dependencies line add the libraries you wish to link to (for example, 
ipps.lib or ippsmerged.lib). 



4-4

4 Intel® IPP User’s Guide

Using Intel® IPP with Borland C++ Builder* Integrated 
Development Environment

You cannot directly link to the Intel IPP static library in Borland C++ Builder*. Instead, try 
the following:

Use the Intel IPP merged static libraries to create a custom DLL (export the functions called 
in your application). The custom DLL and merged static library tools are available as part of 
the integration sample package. The Intel IPP static libraries are located in the 
IPP\6.0.x.xxx\ia32\lib directory. 

Use IMPLIB (on the DLL) to create an import library in the Borland environment. 
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Linking Your Application 
with Intel® IPP 5

This chapter discusses linking Intel IPP to an application, considers differences between the 
linking methods regarding development and target environments, installation 
specifications, run-time conditions, and other application requirements to help the user 
select the linking method that suits him best, shows linking procedure for each linking 
method, and gives linking examples.

Dispatching
Intel IPP uses codes optimized for various central processing unit (CPU). Dispatching refers 
to detection of your CPU and selecting the Intel IPP binary that corresponds to the 
hardware that you are using. For example, in the \ia32\bin directory, ippiv8-6.0.dll 
reflects the optimized imaging processing libraries for Intel®  Core™ 2 Duo processors.

A single Intel IPP function, for example ippsCopy_8u(), may have many versions, each 
one optimized to run on a specific Intel® processor with specific architecture, for example: 
the version of this function optimized for the Pentium® 4 processor is w7_ippsCopy_8u().

Table 5-1 shows processor-specific codes used in Intel IPP:

Table 5-1 Identification of Codes Associated with Processor-Specific Libraries

Abbreviation Meaning

                       IA-32 Intel® architecture

px C-optimized for all IA-32 processors 

w7 Optimized for processors with Intel® Streaming SIMD Extensions 2 (SSE2)

t7 Optimized for processors with Intel® Streaming SIMD Extensions 3 (SSE3) 

v8 Optimized for processors with Intel® Supplemental Streaming SIMD 
Extensions 3 (SSSE3)

p8 Optimized for processors with Intel® Streaming SIMD Extensions 4.1 (SSE4.1)
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Detecting Processor Type
To detect the processor type used in your computer system, use function ippGetCpuType 
declared in the ippcore.h file. It returns an appropriate IppCpuType variable value. All of 
the enumerated values are given in the ippdefs.h header file. For example, the return 
value ippCpuCoreDuo means that your system uses Intel® Core™ Duo processor.

Table 5-2 shows possible values of ippGetCpuType and their meaning.

Table 5-2 Detecting processor type. Returned values and their meaning

Returned Variable Value Processor Type

ippCpuPP Intel® Pentium® processor

ippCpuPMX Pentium® processor with MMX™ technology

ippCpuPPR Pentium® Pro processor

ippCpuPII Pentium® II processor

ippCpuPIII Pentium® III processor and Pentium® III Xeon® processor

ippCpuP4 Pentium® 4 processor and Intel® Xeon® processor

ippCpuP4HT Pentium® 4 processor with Hyper–Threading Technology 

ippCpuP4HT2  Pentium® Processor with Intel® Streaming SIMD Extensions 3

ippCpuCentrino Intel® Centrino™ mobile Technology 

ippCpuCoreSolo Intel® Core™ Solo processor 

ippCpuCoreDuo Intel® Core™ Duo processor 

ippCpuITP Intel® Itanium® processor

ippCpuITP2 Intel® Itanium® 2 processor

ippCpuEM64T Intel® 64 Instruction Set Architecture (ISA)

ippCpuC2D Intel® Core™ 2 Duo Processor 

ippCpuC2Q Intel® Core™ 2 Quad processor 

ippCpuBonnell Intel® AtomTM processor

ippCpuPenryn
Intel® Core™ 2 processor with Intel® Streaming SIMD 
Extensions 4.1 instruction set

ippCpuSSE Processor supports Intel® Streaming SIMD Extensions instruction 
set

ippCpuSSE2 Processor with Intel® Streaming SIMD Extensions 2 instruction 
set
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Selecting Between Linking Methods
You can use different linking methods for Intel IPP:

• dynamic linking using the run-time dynamic link libraries (DLLs)

• static linking with dispatching using emerged and merged static libraries

• static linking without automatic dispatching using merged static libraries

• dynamic linking with your own, custom, DLL.

Answering the following questions helps you select the linking method which best suites 
you:

• Are there limitations on how large the application executable can be? Are 
there limitations on how large the application installation package can be?

• Is the Intel IPP-based application a device driver or similar “ring 0” software 
that executes in the kernel mode at least some of the time?

• Will various users install the application on a range of processor types, or is 
the application explicitly supported only on a single type of processor? Is the 
application part of an embedded computer where only one type of processor is 
used?

• What resources are available for maintaining and updating customized Intel 
IPP components? What level of effort is acceptable for incorporating new 
processor optimizations into the application?

• How often will the application be updated? Will application components be 
distributed independently or always packaged together?

ippCpuSSE3 Processor with Intel® Streaming SIMD Extensions 3 instruction 
set

ippCpuSSSE3 Processor with Supplemental Streaming SIMD Extensions 3 
instruction set

ippCpuSSE41 Processor with Intel® Streaming SIMD Extensions 4.1 instruction 
set

ippCpuSSE42 Processor with Intel® Streaming SIMD Extensions 4.2 instruction 
set

ippCpuX8664 Processor supports 64 bit extension

ippCpuUnknown Unknown Processor

Table 5-2 Detecting processor type. Returned values and their meaning (continued)

Returned Variable Value Processor Type
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Dynamic Linking
The dynamic linking is the simplest and the most commonly used. It takes full advantage 
of the dynamic dispatching mechanism in the dynamic link libraries (DLLs) (see also Intel® 
IPP Structure). The following table summarizes the features of dynamic linking to help you 
understand trade-offs of this linking method.

To dynamically link with Intel IPP, do the following:

1. Add ipp.h that includes the header files of all IPP domains,

2. Use the normal IPP function names when calling IPP functions,

3. Link corresponding domain import libraries. For example, if you use the ippsCopy_8u 
function, link against ipps.lib,

4. Make sure that run-time libraries, for example ipps.dll, are on the executable 
search path at run time. Run the ippenv.bat from directory \tools\env to ensure 
this application built with the Intel IPP dynamic link libraries loads the appropriate 
processor-specific library.

Static Linking (with Dispatching)
Some applications use only a few Intel® IPP functions and require a small memory 
footprint. Using the static link libraries via the emerged and merged libraries offers both 
the benefits of a small footprint and optimization on multiple processors. The emerged 
libraries (such as ippsemerged.lib) provide an entry point for the non-decorated (with 
normal names) IPP functions, and the jump table to each processor-specific 
implementation. When linked with your application, the function calls corresponding 

Table 5-3 Summary of Dynamic Linking Features

Benefits Considerations

• Automatic run-time dispatch of 
processor-specific optimizations

• Enabling updates with new processor 
optimizations without recompile/relink

• Reduction of disk space requirements for 
applications with multiple Intel IPP-based 
executables

• Enabling more efficient shared use of 
memory at run-time for multiple Intel 
IPP-based applications

• Application executable requires access to 
Intel IPP run-time dynamic link libraries 
(DLLs) to run

• Not appropriate for 
kernel-mode/device-driver/ring-0 code

• Not appropriate for web applets/plug-ins 
that require very small download

• There is a one-time performance penalty 
when the Intel IPP DLLs are first loaded
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functions in the merged libraries (such as ippsmerged.lib) in accordance with the CPU 
setting detected by functions in ippcorel.lib. The emerged libraries do not contain any 
implementation code.

The emerged libraries must be initialized before any non-decorated functions can be called. 
One may choose the function ippStaticInit() that initializes the library to use the best 
optimization available, or the function ippStaticInitCpu() that lets you specify the CPU. 
In any case, one of these functions must be called before any other IPP functions. Without 
this, (most often issues) performance of your application is not the best because a “px” 
version of the IPP functions will be called. To illustrate the performance difference, you can 
use the following Example 5-1 in the t2.cpp file:

Example 5-1 Performance difference with and without calling StaticInit

#include <stdio.h>
#include <ipp.h>

int main() {
const int N = 20000, loops = 100;
Ipp32f src[N], dst[N];
unsigned int seed = 12345678, i;
Ipp64s t1,t2;
/// no StaticInit call, means PX code, not optimized
ippsRandUniform_Direct_32f(src,N,0.0,1.0,&seed);
t1=ippGetCpuClocks();
for(i=0; i<loops; i++)

ippsSqrt_32f(src,dst,N);
t2=ippGetCpuClocks();
printf("without StaticInit: %.1f clocks/element\n",

(float)(t2-t1)/loops/N);
ippStaticInit();
t1=ippGetCpuClocks();
for(i=0; i<loops; i++)

ippsSqrt_32f(src,dst,N);
t2=ippGetCpuClocks();
printf("with StaticInit: %.1f clocks/element\n",

(float)(t2-t1)/loops/N);
return 0;

}

cmdlinetest>cl /nologo /Fet2.exe -I "C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\include\" t2.cpp /link /LIBPATH:"C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\lib\" ippcorel.lib ippsemergedem64t.lib 
ippsmerged.lib
t2.cpp

cmdlinetest>t2
without StaticInit: 61.3 clocks/element
with StaticInit: 4.5 clocks/element
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Table 5-4 summarizes pros and cons of the static linking via the emerged libraries you 
should consider before using this particular linking method.

Follow these steps to use static linking with dispatching:

1. Include ipp.h in your code,

2. Before calling any Intel IPP functions, initialize the static dispatcher using either the 
function ippStaticInit() or ippStaticInitCpu()declared in the header file 
ippcore.h,

3. Use the normal IPP function names to call IPP functions,

4. Link corresponding emerged libraries followed by merged libraries, and then 
ippcorel.lib. For example, if the function ippsCopy_8u() is used, the linked 
libraries are ippsemerged.lib, ippsmerged.lib, and ippcorel.lib.

Static Linking (without Dispatching)
This method uses linking directly with the merged static libraries. You can prefer to use 
your own static dispatcher instead of the provided emerged dispatcher. The IPP sample 
mergelib demonstrates how to do this.

Please refer to the latest updated sample from Intel IPP samples directory: 
\ipp-samples\advanced-usage\linkage\mergelib at 
http://www.intel.com/software/products/ipp/samples.htm.

It is most appropriate when a self-contained application is needed, only one processor type 
is supported, and there are tight constraints on the executable size.  One common use is 
for embedded applications where the application is bundled with only one type of 
processor.

Table 5-4 Summary of Features of the Static Linking (with Dispatching)

Benefits Considerations

• Dispatches processor-specific 
optimizations during run-time

• Creates a self-contained application 
executable

• Generates a smaller footprint than the full 
set of Intel IPP 

• Intel IPP code is duplicated for multiple 
Intel IPP-based applications because of 
static linking

• An additional function call for dispatcher 
initialization is needed (once) during 
program initialization

http://www.intel.com/software/products/ipp/samples.htm
http://www.intel.com/software/products/ipp/samples.htm
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Table 5-5 summarizes basic features of this method of linking.

*) for not threaded libraries only.

You can use alternative to above procedure. The Intel IPP package includes a set of 
processor-specific header files (such as ipp_w7.h). You can use these header files instead 
of the IPPCALL macro. Refer to Static linking to Intel® IPP Functions for One Processor in 
\ia32\tools\staticlib\readme.htm.

Table 5-5 Summary of Features of the Static Linking (without dispatching)

Benefits Considerations

• Small executable size with support for 
only one processor type

• An executable suitable for 
kernel-mode/device-driver/ring-0 use*)

• An executable suitable for Web applet or 
plug-in requiring very small file download 
and support for only one processor type

• Self-contained application executable that 
does not require Intel IPP run-time DLLs 
to run

• Smallest footprint for application package
• Smallest installation package

• The executable is optimized for only one 
processor type

• Updates to processor-specific 
optimizations require rebuild and/or relink
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Building Custom DLL
Some applications have few internal modules and the Intel IPP code needs to be shared by 
these modules only. In this case you can use dynamic linking with the customized dynamic 
link library (DLL) containing only those Intel IPP functions that the application uses. 
Table 5-6 summarizes features of the custom DLLs.

To create a custom DLL, you need to create a separate build step or project that generates 
the DLL and stubs. The specially developed sample demonstrates how it can be done. 
Please refer to the latest updated custom dll sample from Intel IPP samples directory: 
\ipp-samples\advanced-usage\linkage\customdll at 
http://www.intel.com/software/products/ipp/samples.htm.

Table 5-6 Custom DLL Features

Benefits Considerations

• Run-time dispatching of 
processor-specific optimizations

• Reduced hard-drive footprint compared 
with a full set of Intel IPP DLLs

• Smallest installation package to 
accommodate use of some of the same 
Intel IPP functions by multiple 
applications

• Application executable requires access to 
the Intel compiler specific run-time 
libraries that are delivered with Intel IPP.

• Developer resources are needed to create 
and maintain the custom DLLs

• Integration of new processor-specific 
optimizations requires rebuilding the 
custom DLLs

• Not appropriate for 
kernel-mode/device-driver/ring-0 code

http://www.intel.com/software/products/ipp/samples.htm
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Summary of Intel IPP Linkage Method Comparison
Table 5-7 gives quick comparison of the IPP linkage methods.

Selecting Intel IPP Libraries Needed by Your Application
The libraries used for each linkage method with regard to particular functional domain are 
listed in Table 5-8. 

Table 5-7 Intel IPP Linkage Method Summary Comparison 

Feature Dynamic Linkage Static Linkage 
with Dispatching

Static Linkage 
without 
Dispatching

Using Custom 
DLL

Processor 
Updates

Automatic Recompile & 
redistribute

Release new 
processor-specific 
application

Recompile & 
redistribute

Optimization All processors All processors One processor All processors

Build Link to stub static 
libraries

Link to static 
libraries and 
static 
dispatchers

Link to merged 
libraries, or 
threaded merged 
libraries

Build separate 
DLL

Calling Regular names Regular names Processor-specific 
names

Regular names

Total Binary 
Size

Large Small Smallest Small

Executable Size Smallest Small Small Smallest

Kernel Mode No Yes Yes No

Table 5-8 Libraries Used for Each Linkage Method

Domain 
Description Header Files Dynamic Linking

Static Linking with 
Dispatching &
Custom Dynamic 
Linking

Static Linking without 
Dispatching

Audio Coding ippac.h ippac.lib ippacemerged.lib ippacmerged.lib

ippacmerged_t.lib
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Color 
Conversion 

ippcc.h ippcc.lib ippccemerged.lib ippccmerged.lib

ippccmerged_t.lib

String 
Processing

ippch.h ippch.lib ippchemerged.lib ippchmerged.lib

ippchmerged_t.lib

Cryptography ippcp.h ippcp.lib ippcpemerged.lib ippcpmerged.lib

ippcpmerged_t.lib

Computer 
Vision

ippcv.h ippcv.lib ippcvemerged.lib ippcvmerged.lib

ippcvmerged_t.lib

Data 
Compression 

ippdc.h ippdc.lib ippdcemerged.lib ippdcmerged.lib

ippdcmerged_t.lib

Data Integrity ippdi.h ippdi.lib ippdiemerged.lib ippdimerged.lib

ippdimerged_t.lib

Generated 
Functions

ipps.h ippgen.lib ippgenemerged.li
b

ippgenmerged.lib

ippgenmerged_t.lib

Image 
Processing

ippi.h ippi.lib ippiemerged.lib ippimerged.lib

ippimerged_t.lib

Image 
Compression

ippj.h ippj.lib ippjemerged.lib ippjmerged.lib

ippjmerged_t.lib

Realistic 
Rendering and 
3D Data 
Processing

ippr.h ippr.lib ippremerged.lib ipprmerged.lib

ipprmerged_t.lib

Table 5-8 Libraries Used for Each Linkage Method (continued)

Domain 
Description Header Files Dynamic Linking

Static Linking with 
Dispatching &
Custom Dynamic 
Linking

Static Linking without 
Dispatching
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Dynamic Linkage
To use the dynamic linking libraries, you must link to ipp*.lib files in the \stublib 
directory, where * denotes the appropriate function domain. All corresponding domain 
libraries used in your applications plus the libraries ipps.lib, ippcore.lib and 
libiomp.lib must be linked to.

For example, your application uses three Intel IPP functions ippiCopy_8u_C1R, 
ippiCanny_16s8u_C1R, and ippmMul_mc_32f. These three functions belong to the 
image processing, computer vision, and small matrix operations domains respectively. To 
include these functions into your application, you must link to the following Intel IPP 
libraries:

Small Matrix 
Operations

ippm.h ippm.lib ippmemerged.lib ippmmerged.lib

ippmmerged_t.lib

Signal 
Processing

ipps.h ipps.lib ippsemerged.lib ippsmerged.lib

ippsmerged_t.lib

Speech
Coding

ippsc.h ippsc.lib ippscemerged.lib ippscmerged.lib

ippscmerged_t.lib

Speech 
Recognition

ippsr.h ippsr.lib ippsremerged.lib ippsrmerged.lib

ippsrmerged_t.lib

Video Coding ippvc.h ippvc.lib ippvcemerged.lib ippvcmerged.lib

ippvcmerged_t.lib

Vector Math ippvm.h ippvm.lib ippvmemerged.lib ippvmmerged.lib

ippvmmerged_t.lib

Core Functions ippcore.h ippcore.lib ippcorel.lib ippcorel.lib

ippcore_t.lib

Table 5-8 Libraries Used for Each Linkage Method (continued)

Domain 
Description Header Files Dynamic Linking

Static Linking with 
Dispatching &
Custom Dynamic 
Linking

Static Linking without 
Dispatching
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ippi.lib

ippcv.lib

ippm.lib

ippcore.lib

libiomp5.lib

Static Linkage with Dispatching 
To use the static linking libraries, you need link to ipp*emerged.lib, ipp*merged.lib, 
ippsemerged.lib, ippsmerged.lib, and ippcorel.lib. 

If you want to use the Intel IPP functions threaded with the OpenMP*, you need link to 
ipp*emerged.lib, ipp*merged_t.lib, ippsemerged.lib, ippsmerged_t.lib, 
ippcore_t.lib, and additionally libiomp.lib.

All these libraries are located in the \lib directory containing domain-specific functions. 
Note that both merged and emerged libraries for all domains plus the signal processing 
domain must be linked to your application.

For example, your application uses three Intel IPP functions ippiCopy_8u_C1R, 
ippiCanny_16s8u_C1R and ippmMul_mc_32f. These three functions belong to the image 
processing, computer vision, and small matrix operations domains respectively.  If you 
want to use the threaded functions, you must link the following libraries to your 
application:

ippcvemerged.lib and ippcvmerged_t.lib

ippmemerged.lib and ippmmerged_t.lib

ippiemerged.lib and ippimerged_t.lib

ippsemerged.lib and ippsmerged_t.lib

ippcore_t.lib

libiomp5.lib

Library Dependencies by Domain (Static Linkage Only)
Table 5-9 lists library dependencies by domain. When you link to the certain library (for 
example, data compression domain) you must link to the libraries on which it depends on 
(in our example, signal processing and core functions).
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 lists library dependencies by domain.

Refer to Intel IPP Reference Manuals to find which domain your function belongs to.

Linking Examples
For more linking examples, please go to 
http://www.intel.com/software/products/ipp/samples.htm

For information on using sample code, please see  “Intel® IPP Samples”.

Table 5-9 Library Dependencies by Domain

Domain Library Dependent on

Audio Coding ippac ippdc, ipps, ippcore

Color Conversion ippcc ippi, ipps, ippcore

Cryptography ippcp ippcore

Computer Vision ippcv ippi, ipps, ippcore 

Data Compression ippdc ipps, ippcore

Data Integrity ippdi ippcore

Generated Functions ippgen ipps, ippcore

Image Processing ippi ipps, ippcore

Image Compression ippj ippi, ipps, ippcore

Small Matrix Operations ippm ippi, ipps, ippcore

Realistic Rendering and 3D 
Data Processing 

ippr ippi, ipps, ippcore

Signal Processing ipps ippcore

Speech Coding ippsc ipps, ippcore

Speech Recognition ippsr ipps, ippcore

String Processing ippch ipps, ippcore

Video Coding ippvc ippi, ipps, ippcore

Vector Math ippvm ippcore

http://www.intel.com/software/products/ipp/samples.htm
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This chapter discusses the use of Intel® IPP in multithreading applications. 

Intel IPP Threading and OpenMP* Support
All Intel IPP functions are thread-safe in both dynamic and static libraries and can be used in 
the multithreaded applications.

Some Intel IPP functions contain OpenMP* code that gives significant performance gain on 
multi-processor and multi-core systems. These functions include color conversion, filtering, 
convolution, cryptography, cross correlation, matrix computation, square distance, and bit 
reduction, etc. 

Refer to the ThreadedFunctionsList.txt document to see the list of all threaded functions in 
the \doc directory of the Intel IPP installation.

See also http://www.intel.com/software/products/support/ipp for more topics related to Intel 
IPP threading and OpenMP* support including older Intel IPP versions of threaded API.

Setting Number of Threads
The default number of threads for Intel IPP threaded libraries is equal to the number of 
processors in the system and does not depend on the value of the OMP_NUM_THREADS 
environment variable. 

To set another number of threads used by Intel IPP internally, call the function 
ippSetNumThreads(n)at the very beginning of an application. Here n is desired number of 
threads (1,...). If internal parallelization is not desired, call ippSetNumThreads(1).

http://www.intel.com/software/products/support/ipp
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Using Shared L2 Cache
Some functions in signal processing domain are threaded on 2 threads intended for the 
Intel® Core™2 processor family, and exploit advantage of merged L2 cache. These 
functions (single and double precision FFT, Div, Sqrt, etc.) achieve the maximum 
performance if both two threads are executed on the same die. In this case these threads 
work on the same shared L2 cache. For processors with two cores on the die this condition 
is satisfied automatically. For processors with more than two cores, a special OpenMP 
environmental variable must be set: 

KMP_AFFINITY=compact

Otherwise the performance may degrade significantly.

Nested Parallelization
If the multithreaded application created with the OpenMP uses the threaded Intel IPP 
function, this function will operate in the single thread because the nested parallelization is 
disabled by default in the OpenMP.

If the multithreaded application created with other tools uses the threaded Intel IPP 
function, it is recommended to disable multithreading in Intel IPP to avoid nested 
parallelization and possible performance degradation.

Disabling Multithreading
To disable multi-threading link your application with IPP non-threaded static libraries, or 
build the custom DLL using the non-threaded static libraries.
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This chapter describes ways you can follow to get the most out of the Intel® IPP software: 
aligning memory, thresholding denormal data, reusing buffers, using FFT for algorithmic 
optimization (where appropriate). Finally, it gives information on how to accomplish the 
Intel IPP functions performance tests by using the Intel IPP Performance Test Tool and 
gives some examples of using the Performance Tool Command Lines.

Memory Alignment
The performance of Intel IPP functions can be significantly different when operating on 
aligned or misaligned data. Access to memory is faster if pointers to the data are aligned.

Use the following Intel IPP functions for pointer alignment, memory allocation and 
deallocation:

void* ippAlignPtr( void* ptr, int alignBytes )

Aligns a pointer, can align to 2/4/8/16/…

void* ippMalloc( int length )

32-byte aligned memory allocation. Memory can be freed only with the 
function ippFree.

void ippFree( void* ptr )

Frees memory allocated by the function ippMalloc.

Ipp<datatype>* ippsMalloc_<datatype>( int len )

32-byte aligned memory allocation for signal elements of different data types. 
Memory can be freed only with the function ippsFree.

void ippsFree( void* ptr )

Frees memory allocated by ippsMalloc.

Ipp<datatype>* ippiMalloc_<mod>(int widthPixels, int 
heightPixels, int* pStepBytes)

32-byte aligned memory allocation for images where every line of the image is 
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padded with zeros. Memory can be freed only with the function ippiFree.

void ippiFree( void* ptr )

Frees memory allocated by ippiMalloc.

Example 7-1 demonstrates how the function ippiMalloc can be used.The amount of 
memory that can be allocated is determined by the operating system and system 
hardware, but it cannot exceed 2GB.

NOTE.  Intel IPP memory functions are wrappers of the standard malloc 
and free functions that align the memory to a 32-byte boundary for 
optimal performance on the Intel architecture.

NOTE.  The Intel IPP functions ippFree, ippsFree and ippiFree can 
be only used to free memory allocated by the functions ippMalloc, 
ippsMalloc and ippiMalloc respectively.

NOTE.  The Intel IPP functions ippFree, ippsFree and ippiFree 
cannot be used to free memory allocated by standard functions like 
malloc or calloc; nor can the memory allocated by the Intel IPP 
functions ippMalloc, ippsMalloc and ippiMalloc be freed by the 
standard function free.
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Thresholding Data
Denormal numbers are the border values in the floating point format and special case 
values for the processor. Operations on denormal data make processing slow, even if 
corresponding interrupts are disabled. Denormal data occur, for example, in filtering by 
Infinite Impulse Response (IIR) and Finite Impulse Response (FIR) filters of the signal 
captured in fixed-point format and converted to the floating point format. To avoid the 
slowdown effect in denormal data processing, the Intel IPP threshold functions can be 
applied to the input signal before filtering. For example:

if (denormal_data)

ippsThreshold_LT_32f_I( src, len, 1e-6f );

ippsFIR_32f( src, dst, len, st );

Example 7-1 Calling the ippiMalloc function

#include "stdafx.h"
#include "ipp.h"
#include "tools.h"

int main(int argc, char *argv[])
{

IppiSize size = {320, 240};

int stride;
Ipp8u* pSrc = ippiMalloc_8u_C3(size.width, size.height, &stride);
ippiImageJaehne_8u_C3R(pSrc, stride, size);
ipView_8u_C3R(pSrc, stride, size, "Source image", 0);

int dstStride;
Ipp8u* pDst = ippiMalloc_8u_C3(size.width, size.height, &dstStride);
ippiCopy_8u_C3R(pSrc, stride, pDst, dstStride, size);
ipView_8u_C3R(pDst, dstStride, size, "Destination image 1", 0);

IppiSize ROISize = { size.width/2, size.height/2 };
ippiCopy_8u_C3R(pSrc, stride, pDst, dstStride, ROISize);
ipView_8u_C3R(pDst, dstStride, ROISize, "Destination image, small", 0);

IppiPoint srcOffset = { size.width/4, size.height/4 };
ippiCopy_8u_C3R(pSrc + srcOffset.x*3 + srcOffset.y*stride, stride,

pDst, dstStride, ROISize);
ipView_8u_C3R(pDst, dstStride, ROISize, "Destination image, small & 

shifted", 1);

return 0;
}
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The 1e-6 value is the threshold level; the input data below that level are set to zero. 
Because the Intel IPP threshold function is very fast, the execution of two functions is 
faster than execution of one if denormal numbers meet in the source data. Of course, if the 
denormal data occur while using the filtering procedure, the threshold functions do not 
help. 

In this case, for Intel processors beginning with the Intel® Pentium® 4 processor, it is 
possible to set a special computation modes - flush-to-zero (FTZ) and the 
denormals-are-zero (DAZ). You can use functions ippsSetFlushToZero and 
ippsSetDenormAreZeros to enable these modes. Note that this setting takes effect only 
when computing is done with the Streaming SIMD Extensions (SSE) and Streaming SIMD 
Extensions 2 (SSE2) instructions.

Table 7-1 illustrates how denormal data may affect performance and the effect of 
thresholding denormal data. As you can see, thresholding takes only three clocks more. On 
the other hand, denormal data can cause the application performance to drop 250 times

Reusing Buffers 
Some Intel IPP functions require internal memory for various optimization strategies. At 
the same time you should be well aware that memory allocation inside of the function may 
have negative impact on performance in some situations as in the case of cache misses. To 
avoid or minimize memory allocation and keep your data in warm cache, some functions, 
for example, Fourier transform functions, can use or reuse memory given as a parameter 
to the function. 

If you have to call f or example, an FFT function many times, the reuse of an external 
buffer results in better performance. A simple examples of this kind of processing are to 
perform filtering using FFT, or computing FFT as two FFT in two separate threads:

ippsFFTInitAlloc_C_32fc(  &ctxN2, order-1, IPP_FFT_DIV_INV_BY_N, 
ippAlgHintAccurate );

ippsFFTGetBufSize_C_32fc( ctxN2, &sz );

buffer = sz > 0 ? ippsMalloc_8u( sz ) : 0;

int phase = 0;

Table 7-1 Performance Resulting from Thresholding Denormal Data

Data/Method Normal Denormal
Denormal + 
Threshold

CPU cycles per element 46 11467 49
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/// prepare source data for two FFTs

ippsSampleDown_32fc( x, fftlen, xleft, &fftlen2, 2, &phase );

phase = 1;

ippsSampleDown_32fc( x, fftlen, xrght, &fftlen2, 2, &phase );

ippsFFTFwd_CToC_32fc( xleft, Xleft, ctxN2, buffer );

ippsFFTFwd_CToC_32fc( xrght, Xrght, ctxN2, buffer ); 

The external buffer is not necessary. If the pointer to the buffer is 0, the function allocates 
memory inside

Using FFT 
Using Fast Fourier Transform (FFT) is a universal method to increase performance of data 
processing, especially in the field of digital signal processing where filtering is essential.

The convolution theorem states that filtering of two signals in the spatial domain can be 
computed as point-wise multiplication in the frequency domain. The data transform to and 
from the frequency domain is usually performed using the Fourier transform. You can apply 
the Finite Impulse Response (FIR) filter to the input signal using Intel IPP FFT functions, 
which are very fast on Intel® processors. You can also increase the data array length to 
the next greater power of two by padding the array with zeroes and then applying the FFT 
forward transform function to the input signal and the FIR filter coefficients. Fourier 
coefficients obtained in this way are multiplied point-wise and the result can easily be 
transformed back to the spatial domain. The performance gain achieved by using FFT could 
be very significant.

If the applied filter is the same for several processing iterations, then the FFT transform of 
the filter coefficients need to be done only once. The twiddle tables and the bit reverse 
tables are created in the initialization function for the forward and for inverse transforms at 
the same time. The main operations in this kind of filtering are presented below:

ippsFFTInitAlloc_R_32f( &pFFTSpec, fftord, IPP_FFT_DIV_INV_BY_N, 
ippAlgHintNone );

/// perform forward FFT to put source data xx to frequency domain

ippsFFTFwd_RToPack_32f( xx, XX, pFFTSpec, 0 );

/// perform forward FFT to put filter coefficients hh to frequency domain



7-6

7 Intel® IPP User’s Guide

ippsFFTFwd_RToPack_32f( hh, HH, pFFTSpec, 0 );

/// point-wise multiplication in frequency domain is convolution

ippsMulPack_32f_I( HH, XX, fftlen );

/// perform inverse FFT to get result yy in time domain

ippsFFTInv_PackToR_32f( XX, yy, pFFTSpec, 0 );

/// free FFT tables

ippsFFTFree_R_32f( pFFTSpec );

Another way to significantly improve performance is by using FFT and multiplication for 
processing large size data. Note that the zeros in the example above could be pointers to 
the external memory, which is another way to increase performance. Note that the Intel 
IPP signal processing FIR filter is implemented using FFT and you do not need to create a 
special implementation of the FIR functions.

Running Intel IPP Performance Test Tool
The Intel IPP Performance Test Tool for the Windows* OS based on Intel® Pentium® 
processors is a very functional timing system designed to accomplish Intel IPP functions 
performance tests on the same hardware platforms as the related Intel IPP libraries run. It 
contains command line programs for testing the performance of each Intel IPP function in 
various ways.

You can control the course of tests and generate the results in the desirable format by 
using command line options. The results are saved in a .csv file. The course of timing is 
displayed on the console and can be saved in a .txt file. You can create a list of functions 
to be tested and set required parameters with which the function should be called during 
the performance test. The list of functions to be tested and their parameters can either be 
defined in the .ini file, or entered directly from the console.

In the enumeration mode, the Intel IPP performance test tool creates a list of the timed 
functions on the console and in the .txt or .csv files. 

Additionally, this performance test tool provides all performance test data in the .csv 
format. It contains data covering all domains and CPU types supported in Intel IPP. For 
example, you can read that reference data in sub-directory \tools\perfsys\data.

Once the Intel IPP package is installed, you can find the performance test.exe files located 
in the \ia32\tools\perfsys directory. For example, ps_ipps.exe is a tool to measure 
performance of the Intel IPP signal processing functions. Similarly, there are the 
appropriate executable files for each Intel IPP functional domain.
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The command line format is:

<ps_FileName>.exe [switch_1] [switch_2] … [switch_n] 

A short reference for the command line options can be displayed on the console. To invoke 
it, just enter -? or -h in the command line:

ps_ipps.exe -h 

The command line options can be divided into six groups by their functionality. You can 
enter options in an arbitrary order with at least one space between. Some options (like –v, 
-V, -o, -O) may be entered several times with different file names and option -f may be 
entered several times with different function patterns. For detailed descriptions of 
performance test tool command line options, see Appendix A, “Performance Test Tool 
Command Line Options”.

Examples of Using Performance Test Tool Command Lines
The following examples illustrate how you can use performance tool common command 
lines to generate IPP function performance data. 

Example 1. Running in the standard mode: 
ps_ippch.exe –B –v

All Intel IPP string functions are tested by the default timing method on 
standard data (-B option). The results are generated in file ps_ippch.csv (-v 
option). 

Example 2. Testing selected functions: 
ps_ipps.exe -fFIRLMS_32f -v firlms.csv

Tests the FIR filter function FIRLMS_32f (-f option), and generates a .csv file 
named firlms.csv (-v option). 

Example 3. Retrieving function lists: 
ps_ippvc.exe -e –o vc_list.txt

The output file vc_list.txt (-o option) lists all Intel IPP video coding 
functions (-e option). 

ps_ippvc.exe -e -v H264.csv -f H264

The list of functions with names containing H264 (-f option) that may be 
tested (-e option) is displayed on the console and stored in file H264.csv (-v 
option). 
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Example 4. Launching performance test tool with the .ini file: 
ps_ipps.exe –B –I

The .ini file ps_ipps.ini is created after the first run (-I option) to test all 
signal processing functions using the default timing method on standard data 
(-B option). 

ps_ippi.exe –i –v

The second run tests all functions, reading timing procedure and all function 
parameters values from the ps_ipps.ini file (-i option) and the output file 
ps_ipps.csv (-v option) is generated. 

For detailed descriptions of performance test tool command line options, see Appendix A, 
“Performance Test Tool Command Line Options”.
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This chapter describes the usage of Intel IPP with different programming languages in the 
Windows*OS development environments, and gives information on the relevant samples.

Language Support
In addition to the C programming language, Intel IPP functions are compatible with the 
following languages (download the samples from  
http://www.intel.com/software/products/ipp/samples.htm): 

Table 8-1 Language support

Language Environment The Sample Description

C++

Makefile The sample shows how Intel IPP C-library 
functions can be overloaded in the C++ 
interface to create classes for easy signal and 
image manipulation.

Microsoft* eMbedded 
Visual C++* 4.0, or 
higher
WinCE 5.0 SDK for 
x86

The sample demonstrates using the Intel IPP 
libraries in the development of applications for 
the Windows* CE environment for x86.

Fortran Makefile N/A

C#* Microsoft .NET C#* The sample demonstrates using the Intel IPP 
functions in a C# wrapper class.

Visual 
Basic*

Microsoft .NET Visual 
Basic*

The demo-application shows calling Intel IPP 
functions from a Visual Basic wrapper class.

Object 
Pascal

Borland Delphi* The sample demonstrates using Intel IPP image 
processing primitives in Borland Delphi*.

http://www.intel.com/software/products/ipp/samples.htm
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Using Intel IPP in Java* Applications
You may call Intel IPP functions in your Java application by using the Java* Native Interface 
(JNI*). There is some overhead associated with JNI use, especially when the input data 
size is small. Combining several functions into one JNI call and using managed memory will 
help improve the overall performance. 

Java* Java Development Kit 
1.5.0

The sample demonstrates using the Intel IPP 
image processing functions in a Java wrapper 
class.

Table 8-1 Language support (continued)

Language Environment The Sample Description
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Table A-1 gives brief descriptions of possible performance test tool command line options.

Table A-1 Performance Test Tool Command Line Options

Groups Options Descriptions

1. Adjusting 
Console Input

-A Ask parameters before every test from 
console

-B Batch mode

2. Managing 
Output

-r[<file-name>] Create .csv file and write PS results

-R[<file-name>] Add test results to csv-file

-H[ONLY] Add 'Interest' column to table file [and 
run only hot tests]

-o[<file-name>] Create .txt file and write console output

-O[<file-name>] Add console output to .txt file

-L<ERR|WARN|PARM|INFO|TRACE> Set detail level of the console output

-u[<file-name>] Create csv-file and write summary table 
('_sum' is added to default title name)

-U[<file-name>] Add summary table to csv-file ('_sum' is 
added to default title name)

-e Enumerate tests and exit

-g[<file-name>] signal file is created just at the end of 
the whole testing

-s[-] Sort or don't sort functions (sort mode 
is default)
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3. Selecting 
Functions for 
Testing

-f < or-pattern> Run tests of functions with pattern in 
name, case sensitive 

-f-<not-pattern> Do not test functions with pattern in 
name, case sensitive

-f+<and-pattern> Run only tests of functions with pattern 
in name, case sensitive

-f=< eq-pattern> Run tests of functions with this full 
name, case sensitive

-F<func-name> Start testing from function with this full 
name, case sensitive

4. Operation 
with .ini Files 

-i[<file-name>] Read PS parameters from .ini file

-I[<file-name>] Write PS parameters to .ini file and exit

-P Read tested function names from .ini 
file

5. Adjust default 
directories and file 
names for input & 
output

-n<title-name> Set default title name for .ini file and 
output files

-p<dir-name> Set default directory for input files that 
is .ini and test data files

-l<dir-name>    Set default directory for output files

6. Direct Data 
Input 

-d<name>=<value> Set PS parameter value

7. Process priority -Y<HIGH/NORMAL> Set high or normal process prioritY 
(normal is default)

-T<cpu-name> Call 
ippInitStaticCpu(ippCpu<cpu-name>)

8. Setting 
environment

-N<num-threads> Call ippSetNumThreads(<num-treads>)

Table A-1 Performance Test Tool Command Line Options (continued)

Groups Options Descriptions
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This appendix describes types of Intel® IPP sample code available for developers to learn 
how to use Intel IPP, gives the source code example files by categories with links to view 
the sample code, and explains how to build and run the sample applications.

For information on configuring Microsoft* Visual* C++ project files for the Intel IPP 
samples, see  “Creating Visual C++ 2005 Project Files for the Intel® IPP Samples”.

For information on generating Microsoft Visual C++ .NET project  and solution files for Intel 
IPP UMC sample code, see   “Building a Microsoft* Visual C++ .NET* Solution for the UMC 
Sample Code”.

Types of Intel IPP Sample Code
There are three types of the Intel IPP sample code available for developers to learn how to 
use the Intel Integrated Performance Primitives. Each type is designed to demonstrate how 
to build software with the Intel IPP functions. All types are listed in Table B-1.

Table B-1 Types of Intel IPP Sample Code

Type Description

Application-level samples These samples illustrate how to build a wide variety of 
applications such as encoders, decoders, viewers, and players 
using the Intel IPP APIs.

Source Code Samples These platform independent examples show basic techniques for 
using Intel IPP functions to perform such operations as 
performance measurement, time-domain filtering, affine 
transformation, canny edge detection, and more. Each example 
consists of 1-3 source code files (.cpp).

Code examples Code examples (or code snippets) are very short programs 
demonstrating how to call a particular Intel IPP function. 
Numerous code examples are contained in the Intel IPP Manual 
(.pdf) as part of the function descriptions.
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Source Files of the Intel IPP Samples
Table B-2 presents the list of files with source code for the Intel IPP samples. All these 
samples are created for Windows* OS, but they can be easily adapted for Linux* OS.

NOTE.  Intel IPP samples are intended only to demonstrate how to use 
the APIs and to build applications in different development environments.

Table B-2 Source Files of the Intel IPP Sample Code

Category Summary Description and Links

Basic Techniques Introduction to programming with 
Intel IPP functions

• Performance measurement 
GetClocks.cpp

• Copying data: Copy.cpp
• Optimizing table-based 

Functions: LUT.cpp  

Digital Filtering Fundamentals of signal processing • Executing the DFT: DFT.cpp 
• Filtering with FFT: FFTFilter.cpp 
• Time-domain filtering: FIR.cpp

Audio Processing Audio signal generation and 
manipulation

• Generating DTMF tones: 
DTMF.cpp  

• Using IIR to create an echo: 
IIR.cpp  

• Using FIRMR to resample a 
signal: Resample.cpp 

Image Processing Creating and processing a whole 
image or part of an image

• Allocating, initializing, and 
copying an image: Copy.cpp  

• Rectangle of interest sample 
wrapper: ROI.h   ROI.cpp   
ROITest.cpp   

• Mask image sample wrapper: 
Mask.h   Mask.cpp   
MaskTest.cpp

http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/dynamic.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/staticdispatch.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/mydll.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/mydll.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/customdynamictest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/usingipp/static.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/basictech/GetClocks.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/basictech/Copy.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/basictech/LUT.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/digfilter/DFT.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/digfilter/FFTFilter.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/digfilter/FIR.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/audio/DTMF.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/audio/IIR.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/audio/Resample.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/Copy.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/ROI.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/ROI.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/ROITest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/Mask.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/Mask.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imageproc/MaskTest.cpp
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Image Filtering and 
Manipulation

General image affine 
transformations

• Wrapper for resizing an image: 
Resize.h   Resize.cpp   
ResizeTest.cpp 

• Wrapper for rotating an image: 
Rotate.h   Rotate.cpp   
RotateTest.cpp 

• Wrapper for doing an affine 
transform on an image: Affine.h   
Affine.cpp   AffineTest.cpp  

Graphics and Physics Vector and small matrix arithmetic 
functions

• ObjectViewer application: 
ObjectViewerDoc.cpp   
ObjectViewerDoc.h   
ObjectViewerView.cpp   
ObjectViewerView.h 

Transforming vertices 
and normals: 
CTestView::OnMutateM
odel 

Projecting an object 
onto a plane: 
CTestView::OnProjectPl
ane 

Drawing a triangle 
under the cursor: 
CTestView::Draw

• Performance comparison, 
vector vs. scalar: perform.cpp

• Performance comparison, 
buffered vs. unbuffered: 
perform2.cpp

Table B-2 Source Files of the Intel IPP Sample Code (continued)

Category Summary Description and Links

http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Resize.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Resize.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/ResizeTest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Rotate.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Rotate.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/RotateTest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Affine.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/Affine.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/imagefilter/AffineTest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/ObjectViewerDoc.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/ObjectViewerDoc.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/ObjectViewerView.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/ObjectViewerView.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/perform.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/graphics/perform2.cpp
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Using Intel IPP Samples
Download the Intel IPP samples from  
http://www.intel.com/software/products/ipp/samples.htm.

These samples are updated in each version of Intel IPP, it is strongly recommended to 
upgrade Intel IPP Sample when a new version of Intel IPP is available.

System Requirements
Refer to the readme.htm document in the root directory of each sample to learn the 
system requirements for the specific sample. Most common requirements are listed below.

Hardware requirements: 
• A system based on an Intel® Pentium® processor, Intel® Xeon® processor, or a 

subsequent IA-32 architecture-based processor 

Software requirements: 
• Intel® IPP for the Windows* OS version 6.0 

• Microsoft* Windows Vista*, Microsoft Windows XP*, Microsoft Windows Server* 2008, 
or Microsoft Windows Server 2003 operating systems

• Microsoft* DirectX* API: 9.0 SDK Update (February 2005) or SDK (December 2005) 

• Intel® C++ Compiler for Windows* OS: versions 10.1, 10.0 or 9.1Microsoft Visual 
C++* .NET 2008, or Microsoft Visual C++ .NET 2005 development systems 

Special-Purpose Domains Cryptography and computer vision 
usage

• RSA key generation and 
encryption: rsa.cpp   rsa.h   
rsatest.cpp   bignum.h   
bignum.cpp   

• Canny edge detection class: 
canny.cpp   canny.h   
cannytest.cpp   filter.h   
filter.cpp   

• Gaussian pyramids class: 
pyramid.cpp   pyramid.h   
pyramidtest.cpp  

Table B-2 Source Files of the Intel IPP Sample Code (continued)

Category Summary Description and Links

http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/rsa.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/rsa.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/rsatest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/bignum.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/bignum.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/canny.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/canny.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/cannytest.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/filter.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/filter.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/pyramid.cpp
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/pyramid.h
http://download.intel.com/support/performancetools/libraries/ipp/webExamples/specialdoms/pyramidtest.cpp
http://www.intel.com/software/products/ipp/samples.htm
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• When building for a processor supported the Intel® 64 architecture, the Microsoft 
EM64T Platform SDK is required. 

• When building for an Intel® Itanium® 2 processor, the Platform SDK for Microsoft 
Windows Server 2003 SP1  is required 

• Microsoft eMbedded Visual C++ 4.0 tool with the Service Pack 4 (SP4) 

When building for the Windows CE OS version 5.0 for x86, Standard Software 
Development Kit (SDK) for Windows CE 5.0 operating system is required 

Building Source Code
The building procedure is described in the readme.htm document for each sample. Most 
common steps are described below.

Set up your build environment by creating an environment variable named IPPROOT that 
points to the root directory of your Intel IPP installation. For example: C:\Program 
Files\Intel\IPP\6.0.x.xxx\ia32\.

To build the sample, change your current folder to the root sample folder and run batch file 
build32.bat [option]. 

By default batch file searches the compilers step by step according to the table below 
(assuming that compiler is installed in the default directory). If you wish to use Intel 
C/C++ compilers or Microsoft C/C++ .NET 2005 compiler, set an option for batch file 
according to the table below.

Table B-3 Options for Batch Files

Compiler Script Option

Intel C++ Compiler 10.1 for Windows OS icl101 

Intel C++ Compiler 10.0 for Windows OS icl10

Intel C++ Compiler 9.1 for Windows OS icl91

Microsoft Visual C++ .NET 2008 software cl9

Microsoft Visual C++ .NET 2005 software cl8

Microsoft Visual C++ .NET 2003 software cl7
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After the successful build, the result file or files are placed in the corresponding sample 
directory: <install_dir>\ipp-samples\sample-name>\bin\win32_<compiler>,

where compiler = cl7|cl8|cl9|icl91|icl10|icl101.

Running the Software
To run each sample application, the Intel IPP dynamic link libraries must be on the system’s 
path. See “Setting Environment Variables” for more details.

Refer to the readme.htm document in the directory of the specific sample for detailed 
instructions on how to run the application, list of command line options or menu 
commands.

Known Limitations
The applications created with the Intel IPP Samples are examples intended to demonstrate 
how to use the Intel IPP functions and help developers to create their own software. These 
sample applications have some limitations that are described in the section “Known 
Limitations” in the readme.htm document for each sample.

NOTE.  If you use the Windows CE OS version 5.0, it is necessary to 
choose or set the PLATFORM in wceplatform.bat to targeted one. Make 
sure you use valid SDK for your platform. Probably you'll need to set the 
SDKROOT environment variable manually, for example: 
set SDKROOT=C:\Program Files\Windows CE Tools
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